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Zedmed v36.9.0

Fixes and enhancements

. Doctors can now be made available for Online Appointment bookings by branch
Office ZED-7895 The practice can now set each doctors availability for Online Appointment by practice branch
You can now specify if an appointment type is available for patients who are new, returning or both.
This OLA feature allows appointment types to be made available online and for new, or returning patients, or both,
Office/ to be able to make an Online Appointment using the appointment type.
OLA ZED-9277
Planned Referral letter requirement: Zedmed supports the planned Referral Letter requirement for new
patient bookings. This feature is not yet supported in Online Appointments.
Zedmed now has a setting to manage the order of the doctors displayed in Online Appointments
Office ZED-9274 | Asetting (pin to top) has been added to Zedmed that allows the practice to specify the order in which doctor's names
are displayed in the Online Appointments booking page. Note: this feature is not yet live in OLA
Locked Appointment Book slots for OLA bookings can no longer be cancelled (only deleted)

) When an Online Appointment is being booked, the slot in the Appointment Book that the patient chose is locked
Office ZED-9460 | while they complete the booking process. Practice staff can now NOT cancel locked appointment slot. They can only
/OLA DELETE the locked appointment slot. A patient will get an 'unsuccessful booking' message when they try to make a

booking and practice staff delete the slot that was locked for that booking.
Zedmed v36.8.1
Add all missing Cubiko database tables to list of tables Cubiko needs to access

) Two additional Zedmed database (SuperPlus) tables have been added to Cubiko accessible list of tables:

Office | ZED-9447 |4 pATIENT_FILE_NUMBERS
2. TAX_CODES
Zedmed v36.8.0

Fixes and enhancements

Error encountered when trying to delete an attendance

Office | ZED-9385 | Fixed anissue that prevented the deletion of an attendance if a bulk billing consent request has been sent to the
patient.
Out-of-range error in the appointment grid

Office ZED-9387 Fixed an issue where moving fc'>rward inthe ?ppointment grid to a week that has an unavailable slot for a doctor
caused an out-of-range exception error to display.

Office/ Secure Send not working due to an incorrect URL

Clinical ZED-9388 | The secure Send production URL has been fixed.
The Referrals Expiring Report showed patients all expired referrals

Office ZED-9409 | The Referral Expiring report has been updated to suppress multiple entries for patients with more than one expired
referral for the same doctor. Now such patients will appear once along with the most recently expired referral date.

Zedmed v36.7.0
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NEW Electronic bulk bill consent

The doctor's billing screen has a Bulk Bill Consent button that sends an SMS consent request to the patient. The SMS links to a page
containing the encounter's services and cost. The patient can read the information and select Accept to consent to be bulk billed. This
consent is recorded and will show on the invoice screen as "Medicare consent received" when reception does the billing. To learn
more see the new Bulk billing consent guide.

Patient Hame Jones, Mr Happy ova Medicare Number 29508620412 Satety et
DOB 04121864 HCC Pension Status None Encounter Duration (:00:26
payer [ Medicare MC 500 ~] Send Medlcare Bulk Hlling Cansent ) contigure
‘Search Tof itém by numMDEr of description Seledted Items
| Pl s Level B Surgery Cansultation
Recent items
a Level B Surgery Cansultation

TEST - — T
Consent Request Confirmation |

4 Medicare Bulk illing Request will be sent to the patient using the mobile phone number and date of birth
displayed below. The mobile number can be changed here without affecting the patient record.

Patient Mame Janes, Mr Happy

Mobile Mumber |0491 573 087

Date of Brth 04/12/1964

N
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NEW Marketing Messages

You can now use SMS to send informational and promotional messages to select groups of patients using our new Marketing
Messages feature. To learn more see the Marketing Messages guide.

Marketing Messages

»* Patient Demographics

] Exclude Casual Patients

D age I 0

] sex at Barth Male | Female

] Has Veteran Card Ves Ho

[ Has medicare cara Yes Mo

[ Has Health Care Card (= ey No

asi

None Selected

#* Appointment Criteria

[~] Filter by Appointments

(®) Both Attended and Unattended () Attended Only O Unattended Only
Date from Date to Branches 11 selected)
[1orosr2024 & B [10rs/2024 ClN=l [Branch 1 =l
Appointment Types Dactors (13 selected)
Hone selected | rthur, Lesley, Baykin, E ...

Resources
None selected

Report Columns

] patient Full Name [ sex at Birtn [] Mobile Phone

] Address [ age [] Home Phone

[] Appointment Date/Time [[] work Phone

1 of 1 message(s) queued for SMS... process completed.

Erint Screen Export View History | Send SMS

NEW Allow bookings from different OLA accounts to link the same patient record

Patients booked for OLA appointments with their own account can also have an appointment booked under a family member's OLA
account. E.g, a mother adds their child to their OLA account as a family member and books an appointment. That child can still create
their own OLA account and book an appointment and both appointments will use the same patient record.

NEW Cubiko
Zedmed has added support for the Cubiko practice intelligence service. There is a direct link for Cubiko customers to access the

Cubiko App on Zedmed's Management tab. A subscription to Cubiko is required to use this service. To learn more about this paid
service, visit the Cubiko website.

To learn more see the Zedmed Cubiko guide.
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NEW Credit Card Payment Support for Online Appointments
Practices can enable Online Credit Card payments for specific practitioners and appointments. The Credit Card information is
requested when the patient makes the appointment and used for billing after the appointment.

UPDATE: Update Return to Work SA
The way Zedmed users access Return to Work SA Work Capacity Certificates (eWCC) has changed. Telstra Health still hosts RTWSA
but the access point is changing to HealthLink Smartforms, which Zedmed is already integrated with. To learn more, see the RTWSA

guide.

Fixes and enhancements

The Surgical Procedures report will now always show the Patient's Fund details.
Office | ZED-8993 | Thereport previously only listed the Patient's Insurance Fund details when there was a quotation attached to the
procedure.
Secure Send is now correctly working for payment receipts in Office.
Office | ZED-9134 | The 'Send to Patient' button was not working correctly for Receipts. This has been resolved and you can now Print,
Email and Secure Send payment receipts from Office.
RTW SA forms are now displayed in Clinical'sSummary Views.
Office ZED-9356 | RWSA Work Capacity Certificates are now submitted using HealthLink SmartForms and Zedmed has been updated
to save these forms in Summary Views > Documents.
) Fixed the error "AppointmentList is empty" that appeared when clicking Bill.
Office ZED-9352 This error occurred when clicking Bill in the Appointment Book without having an appointment slot selected.
Office & Intramail's subject field is no longer truncated to 40 characters.
Clinical ZED-9138 The intramail subject will now display the full 100 characters in both Office and Clinical.
. The correct message will now display when selecting Reply in Intramail.
Office & ZED-9194 | Fixed the issue which in some instances caused a different message from the one selected to be displayed when
Clinical replying or forwarding an intramail message.
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Office &
Clinical

ZED-9247

Text selection is now supported for PDFs so you can Copy/Paste text in Clinical and Office .

Two additional toolbar buttons have been added to the viewer for PDF documents in Clinical and Office that switch
the mouse action between panning the document and selecting text. This allows text within the PDF to be easily
copied and pasted into other documents.

Result View Enhanced View
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Clinical

ZED-7662

The Problem/RFE window will now correctly update when switching tabs or reopening an encounter.
When switching between problem tabs during a patient encounter, the incorrect information for the selected
problem was displayed.

Clinical

ZED-8991

Blood O2 Saturation Values are now supported in Patient Observations.

The Patient Observations screen now enables the recording of Blood Oxygen Saturation measurements. The new
measurements are included in the General Measurement Reports and in the MergeFields in the Template Editor and
Letter Writer.

Date of Obsenvations: | 10/05/2024 M Add Another Set of Obsernvations
Physical | INR Pathology ) Respiratary Function

Biood Pressure General
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1]

Waist Measurement (cmf |

EEEEE
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Clinical

ZED-9006

A securely sent Referral Letter will display a warning if you select Secure Send again in the same letter.
This is to avoid the same Referral Letter being accidentally sent to a patient more than once. This update does not
apply to Pathology or Radiology Referrals.

Clinical

ZED-9141

Zedmed has added the Vision Radiology template to Clinical.
This means you can now print referrals to Vision Radiology paper when writing a Radiology Referral. Selecting a
recipient laboratory from the Referrals module sets the template to be used.

Clinical

ZED-9193

The Clinical History User Group field now displays the assigned group when editing a staff member.
In Zedmed Security Roles and Users, there was an issue where Clinical user groups were blank when opening User
details.

OLA

ZED-9201

Fixed a time-out issue that prevented Upcoming or Previous appointments from displaying.
This problem prevented appointments from appearing in the My Appointments area.

Utilities

ZED-9001

Fixed the error "Access Violation" when running Pattie.
This issue occurred when Zedmed wrote to the log files that caused the Pattie system to crash.
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Zedmed v36.6

Upgrading to this version will provide the following updates.

IMPORTANT: This upgrade will update your eRx certificate and change the communication endpoint from HTTP to HTTPS.
This update is required because the erx.com.au :8830337559 certificate isexpiring on 25 June 2024 and the eRx Adapter must be
updated to ensure continued operation of the eRx service. HTTPS will use a different port and the eRx web address will change to
HTTPS. If you use a firewall with port/internet restrictions, you may need to open a new port to support the new endpoint.

NEW Referrals Expiring Report
This report allows the practice to see expiring referrals by Date, Practitioner and Appointment Type and send SMS notifications to
patients regarding their referrals. Learn more.

NEW Billed status in the Appointment Book
A $icon (screenshot below) will now appear in the Appointment Book next to patients who have an invoice raised for an attendance.

455 ) 17 Jones, Marrianna-Louise Std Consultatiogh]
I

NEW ATSI status in Clinical
The ATSI status in the patient's record is now reflected in Clinical with icons.

S\ \
Open Patsent Y O nt Op ¥ Clos

Jones, Ms Marrianna-Louise [E{ | Jones, Ms Marrianna-Louise [E

Coble, Mr Bartholomew Jones, Ms Marrianna-Louise

NEW Drugs Module without MIMS
Zedmed's Dugs module can now be used to create prescriptions without MIMS.

AP| ZED-9284 Move Office interface endpoints from Hl service into Zedmed API for Jayex
Office interface endpoints have been migrated from the old Hl service into the Zedmed API for Jayex.

Created Jayex rest APl endpoints in Zedmed API (This update applies to Jayex kiosk customers).
Jayex APl has been moved from HI Service into Zedmed API (by default the port number is 9821).

API ZED-9230 |Inthe CRS_App_Server.iniis still required for the Jayex integration to work - please note that the config:
[OfficeHIService]

RunRestService=Yes

Further enhancements to Zedmed's internal process logging
System |ZED-9336 |Added more targeted logging surrounding the clinical service hang issue. Made a change to MIMS
initialisation that may fix the hanging issue and changed the MIMS config use of database connections.

Enhanced Zedmed's logging functionality

Improved the options available to log Zedmed's internal processes when troubleshooting problems. This
improved logging level can only be manually enabled and disabled by Zedmed on the practice installation
once the practice provides access. Changing logging levels requires a restart of the Zedmed service.

System |ZED-9294
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Office

ZED-9195

Add the eRx certificate updater to the Zedmed upgrader which changes the communication endpoint from HTTP
to HTTPS

This update is required because the erx.com.au :8830337559 certificate is expiring on 25 June 2024 and the eRx
Adapter must be updated to ensure continued operation of the eRx service. HTTPS will use a different port and the
eRx web address will change to HTTPS. If you use a firewall with port/internet restrictions, you may need to open a
new port to support the new endpoint.

Office

ZED-9256

Fixed performance issues and missing QR codes for printed electronic prescriptions
Replaced the application used for QR Code Generation to improve the performance and resolve a missing QR
code issue when printing paper prescriptions with eRX enabled.

Office

ZED-8859

Create a new report "Referrals Expiring Report"
A new report is available in Office to show patients with upcoming appointments for which their referral letter has
expired. The Referrals Expiring Report can be found in Management > Reports.

Office

ZED-8899

Add a Billed symbol to the appointments screen once a patient has paid/been billed
Zedmed Office now displays a billed icon on the appointment screen after a patient has been admitted and billed.

Office

ZED-8940

On Patient Details Other Contacts set default phone number to Mobile
Next of Kin and Emergency Contacts now default to Mobile Phone rather than Home Phone in Patient Details.

Office

ZED-8952

Dr Name merge field not working in SMS reminders when a title is not specified
Scheduled Appointment Confirmation, Reminder and Recall messages that include the Doctor Name merge field
now correctly include the Doctor's Name for a doctor who does not have a Title specified.

Clinical

ZED-9343

Fixed an eScript Error that occured if a drug had an AMT-MPP code but no AMT-TPP code.
The drugs known to have this issue are: Gabapentin 100mg Oral Capsule 100mg [100] & Tamsulosin hydrochloride
400mcg Modified Release Tablet 400mcg [30].

Clinical

ZED-8836

Prevent failure to load HealthLink forms when one of the HL7 files cannot be loaded
Issue that caused failure while loading HealthLink Forms if an HL7 file is corrupted has been fixed. Now forms will be
loaded even if a corrupted file was detected. Corrupted files or data parts will be skipped.

Clinical

ZED-9128

Fixed an issue causing MHR upload failures
Fixed the issue that caused the MyHealth Record upload process to fail when marking jobs as ready to be sent.

Clinical

ZED-8870

Zedmed APl issue - An Invalid Connection String Argument
The issue that caused the “An Invalid connection string argument” error during the MIMS update check or when
prescribing electronically has been resolved.

Clinical

ZED-8872

Validate Email and mobile data entered into the Address book

Zedmed Clinical now validates the email and mobile phone fields when creating or editing a contact in address book.
The email entered must conform to "user@hostname" pattern, whereas mobile phones must be 10-digits long
(without spaces), or up to 12-digits long (with spaces) and begin with "04".

Clinical

ZED-8855

Disabling use of MIMS as a database does not allow to use Drugs Module

Added the ability to use the prescribing module in clinical without having MIMS installed. Un-check the "Use MIMS
for Medication Database" option in the Drugs tab of Global Options Note that only recipe drugs will be available to
prescribe.

Clinical

ZED-8894

Save column order not working in My Options
Zedmed Clinical medications dialog will now remember user-specified grid column order and widths on the "Existing
Drugs" tab page.

Clinical

ZED-8897

Add ATSI status to the patient demographics
A patient's ATSI status is now displayed graphically in the Patient Details screen within Clinical.

Clinical

ZED-8908

Change the pregnancy shortcut key from ctrl-B to something else that is available
The keyboard shortcut to open Encounter > Pregnancy module has changed from Ctrl-B to Ctrl-Alt-B.
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Current/Resolved problems move arrow not enabled when moving to next item
Clinical | ZED-8910 |Fixedissue thatrequired an extra click away from the list to re-enable the arrow to move problems from Current to
Resolved or vice versa.

Uncheck authority if private is selected as PBS Status in Prescription Script details
Clinical | ZED-8912 |When prescribinga Drugwith a PBS Status that requires an Authority, if the status is changed to Private, the
Authority checkbox is now automatically cleared

Global options Max file upload size text box is incorrectly displayed on all tabs
Clinical | ZED-8944 | A cosmeticissue has been fixed on Clinical global options dialog where the max file upload size edit field would
continue to display on all tab sheets.

Letter Writer - Insert > Today's Notes inserts the text with incorrect formatting
Clinical | ZED-8953 |When "Todays Notes" are inserted from the Letter Writer in Clinical the notes no longer contain additional blank
lines.

Fix buttons displayed on allergies message box question
Clinical | ZED-8980 | Whenchanges to a patient allergy are about to be inadvertently lost, the confirmation message box now displays Yes
and No buttons rather than Yes and Ok buttons.

Zedmed v36.5

Upgrading to this version will provide the following features and updates.
To assist with the adoption of these new features, see theZedmed v36.5.2 checklist.

NEW Electronic signatures
Electronic signatures can now be added to letters and referrals by applying the 'signature image' merge field. Simply save the
practitioner's signature as an image file and upload it to their profile. Learn more.

NEW Secure Send
Secure Send is a feature that uses email or ZedSMS to send invoices, documents and referrals (including radiology and pathology
referrals) to the patient or payer using a link to a secure download. Learn more. To enable Secure Send, submit a request form.

NEW Automatic recall reminders
SMS recall reminders can now be scheduled to go out automatically using the same process as scheduled appointment reminders in
Zedmed's SMS Configuration console. Learn more.

NEW MyMedicare support

MyMedicare is a voluntary patient incentive scheme designed to formalise the relationship between patients and their practitioners.
This update supports MyMedicare bulk billing incentive items, and the ability to record and display a patient's MyMedicare
registration status in Zedmed. Learn more.

Resolved Error: Cannot Reconcile Patient - Duplicate Message_ID
Office ZED-8766 | Fixed an error that could occur when performing a provisional patient merge. This error would occur when the
patient already exists in Zedmed and replies to an SMS before the patient reconciliation occured.

Resolved an Error that appeared when adding a patient to an appointment from the waiting list.
Office ZED-8767 |Fix anerror that occurred when adding a patient to an appointment using the cancellation waiting list - if an
SMS reminder had already been sent for the existing appointment.

Resolved Error Code 400 when creating a Doctors App QR Code.
Office ZED-7765 | Fixed an error that could occur when creating a Doctors App QR code in Zedmed. The code is scanned by a
user to enable to app on their device.
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New Medicare Plus Incentive items
A notification will advise if New Medicare Plus Incentive scheme items are available to the patient during
billing. This includes the new MyMedicare incentives.
The following billed items qualify for Medicare Plus Incentive items.
Click 'Add Items’ to automatically add the ticked items to this invoice.
Office | ZED-8794
r;e:me Items Description
o 10990(25/10/2023) 23 for service item of Group Al of Category 1
Fixed the Results Inbox sort order
Clinical |ZED-8978 | The Results Inbox now sorts the results correctly when sorting by the Result Reported Date when you use Get
all Results for a Patient button. The Result Reported Date is the date of collection/testing
New Radiology referral template: iMed Radiology Imaging Specialist
Clinical | ZED-8589 clology prate: ! 8Y Imaging >p . o
The Radiology-MedReferralSpecialist request form is now available as a Radiology Form in Clinical.
Clinical |zED-8881 New Radiology report template: iMED Radiology - Myocardial perfusion imaging request
inica -
The report template Radiologyl-MedMyocardialPerfusionlmaging is now available in Clinical.
The red lines in Zedmed's modern Ul option can be changed to grey
Added the ability to change the red lines separating each section in the Clinical Ul to grey lines. This is changed
in Clinical Tools > My Options > General tab under Line Colour: Red/Grey.
Show |Last 10 Consultations v | InHistary View Use Chronic Disease Module
Default Template N . O ves Oivio @ Site Default
Document Template |Ref Letter - Standard I | Clear |
e — — Censultation Timer Alert
H. Themes Line Colour
Clinical | ZED-8702 O Classic ® Modern @ Red O Grey [Juse Consultation Alert | Beep t End Time
Address Book ert Time [mins) |15 %
(O Ask Every Time (@) Zedmed () HeaithShare
) o oK X cancel
Removed Measurements from the Clinical document writer's Details Merge fields
Clinical |ZED-8728 | Removed the outdated "Measurements" merge field from the Clinical document writer's template tools. The
"Measures" merge field should be used going forward.
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AIR Update - New mandatory field: Vaccine Type (Regulatory compliance update)
Added a new field mandatory field called Vaccine Type that will be required for government compliance in
March 2024, and expanded the Route option descriptions.

Immunisation x
Doctor
Branch: Albany Road Clinic | [I Mot Given Here
Mame: | Phillip Davis v

Administerad Overseas

Immunisation Dretails

Brand/Vaccine: '

| Manual.
Dlndud! non-AlR vaccinations

Date Given: | 10/01/2024 =
Dose: School ID: Required only if immunisation

administered at a school

Batch Number: ~ | [store Batch No. (available from the ACARA

Australian Schools List)

Clinical |ZED-8802

site: | -
Route: [ ]intramuscular [] Subeutaneous [ ] Oral [ Intradermal
I Vaccine Type: [ ] Antenatal CINIP or Commonwealth [ ] Private || State Program ]
Comment: | |
Add Recall [ o oK [ X cancel
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Send directly to pharmacy option for electronic prescriptions (Regulatory compliance update)

On the Electronic Prescriptions screen, there is now a "Send directly to Pharmacy" checkbox with a reasons
drop-down. This option will print out a QR code (token) for the prescription that can be faxed or scanned then
emailed directly to the pharmacy. This is for compliance with state and territory legislation that prevents
prescriptions from being given to patients for specific controlled substances.

Flectronic Prescription
Dr Phalip Crawis RACGE | Motes for pharmacist [staged suppdy, specal approval, spectic condition, ete.
Ernch 1 HOTE: may be visitle o patiert.
Lewed 3, &0 Albert Road
SOUTH MELBOURNE 3205
Fresiber Number: 3677773 Phane Number: 03 8264 3300
Fatient's Mame Ms Marrianna | oulse lones Fatient's Medicare ITBOIIETHY
Address 6 Janes Pl
GOWRIE 2804 Fhamaceutical eretits entalement Raute of Adminstration =]
number
Date of Birth  19/05/1967 FESSayNet  []  Concessianal or sepencant O | Clinical Indication -
entitlement card RPES benehicary or PES Satety
Date /012024 holder et card halder
Minimum Repeat intersal [days) |
FES [ APEs [ Eand substitutions not permitted ]
‘Warmant number
Rosuvastatin
smy Coated Tablet 5mg [30] [Clunusual Dase
PUFF
[ ] Senpt s tar urgent supply |seript awing)
Qty: 1730 5 repeats
Electronit Preseribing Taken delivery
Osms (06997730
Clinical |ZED-8781 Omit [
(Mo Electronic Token
(I Print Paper Token
1B Unioad seript o Active Script List
() sena prescrpton aect o Parmacy  Aeasar: | Dasing Por 3
The aption sbove will prevent the palient from receiving the Loken, It is intended thal the paper Loken
[ Prted an rouiaed directy o foe gharmary.
This i due Lo & requirement in indnidual stale and eritory legiststion thal arevents prescrptions from
being handed aver to the patient for specific controlled substances.
— v,
[ Presuibe Betbonically | Caneel
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Dosage information is now mandatory for all prescriptions (Regulatory compliance update)
Prescribing now requires dosage information in the Dosage Full Text field. This is a compliance update for
electronic prescribing that has been applied to all scripts.
[ 7 =
Atenolol 50mg Coated Tablet 50mg [30]
You selected: Atenalol S0mg Coated Tablet Tablets) SO0mg [30] A
Dosage Frequency Instructions MIMS Reference Information
capsule | after meals | A, The MIMS information displayed below is of product °Atenolol REX Tablets Somg (307", this
Half 2 drop | as directed infarmation may vary for other products/brands with the same generic name.
: | =il !".‘l'::“ i:::.‘;ﬂ"' | MINS Dosage
Ztimes a day | before meals Admin > 100 mg/day as divided dose. Hypertension: initially 50 mg/day; may incr by 50 mg/day every
1 3times a day in the morning wi to max 200 mg/day. Angina: inttially 50 mg/day; may iner to 100 mg/day. Arrhythmia
4 5 6 4 times a day maintenance: 50-100 mg/day. Mi maintenance: S0 mg/day for 1-3 yrs. Initiate after early intervention
every 4 hours with other agents or immediately if patient presents > 12 hrs post-ML Renal impairment. CICr 15-35
every 6 hours mi/min: 50 mg/day or 100 mg on altemate days; CICr < 15 mL/'min: 50 mg on alternate days or 100
¥ 8 9 onge a day mg every 4th day, haemodialysis: SO mg after dialysis. Elderny. consider dose redudtion. Withdrawal:
il - weekly reduce gradually over 8-14 days
Cir L] 00
Clinical |ZED-8840 - Drua Use
Error x all grades incl renal origin; frequent disabling angina
Cakulator arhythmia; MI {late intervention) (> 12 hrs after chest pain
9 Dosage for use) must be order
to presaribe, b
Josage Full Test F—
J e
7 Undo ™~ Redo ' T ciear
(®) Regular Use (O PRN () Short Term
Quantity |1*30 | Repeats _ FES does not allow repeats
Script Date:  |19/12/2023 [ PBS Status
[]Hide from display (archive) f not curent  Medicine estimated ta last until [1501/2024 |12 et e e etianjiN
A upload script to Active Seript List [A Wain me to renew script after |o9|t|uzoz4 T Orega4 Include Brand on Script
[ Autharity Brand Substitution MOT Parmitted
Drug Motes
|Add to encounter notes
MIMS P, BIMS CHL _‘;ﬁ_ndd anh &;u_!n History -_ |ﬂ Preseribe ﬁearomu‘lul | v Prescribe x Lancel
New Practitioner ID option as an alternative identifier for Online Appointments.
Zedmed can generate a Practitioner ID so a doctor can be set up for Online Appointments. This is ideal for
treating doctors without an HPI-I. The Practitioner ID is assigned in the doctor Details screen, along with the
Available Online setting for OLA.
Clinical Settings
Qualification |M88S Details New
Status
Presaiber No I External Primary | = Available}
| = Dlassist only Diurg";on Oﬂh'“r rﬁ,,!\!,l,n,s,,,, 5
Email Address
OLA ZED-8650 | ECUIPSE Fund Schemes [Jshow Code on Appt. Screen
ZED-8649 Onling Appointment System Text for specialty treatment
Practiioner 1D T ROUTERTIT Iptarmation 2
|[992°1 FAD- i | Generate
Signature Image
Find [
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Patients must now choose an appointment type in Online Appointments

Online Appointments no longer has a default appointment type. Patients must select an appointment type to
create a booking, ensuring they book for the intended appointment type. This prevents patients from booking
the incorrect appointment type and allows you to only give new patients a new patient appointment type.

O EEREER N What type of appointment are you

booking today?

[ 5td Consultation l I Review Consultation I

&

Zedmed v36.3.4

Upgrading to this version will provide the following updates.

o Resolved Error: Item not found when closing a patient file in Zedmed Clinical.
Clinical | ZED-8867 This error occured when opening a patient in Clinical from Office, if Clinical had not been shut closed properly.

o Resolved Error: List Index (1) out of bounds.
Clinical | ZED-8886 This error also occured when opening a patient in Clinical from Office, if Clinical had not been shut closed properly.

. Resolved Error: Unsatisfied constructor on type: MyHealthRecord.Conversion.TMhrDocumentView.
Clinical | ZED-8865 The error occurs when trying to view a result that has been added to the summary view from My Health Record.

Resolved Issue with Zedmed Upgrade file v36.3.3
Upgrader | ZED-8882 The error prevented some users from upgrading.

Zedmed v36.3.3
NEW HealthShare integration

The Clinical Address Book is now integrated with HealthShare so practitioners have access to Australia's most used Specialist and
Allied Health directory for letters and referrals. This feature requires internet access. Learn more in our HealthShare guide.

NEW Intramail search

There is now a search option in Office and Clinical Intramail so you can search your inbox and sent items for mail using the sender's
name, subject, date range or a linked patient. Learn more in our Intramail guide.

NEW Editor for Office templates

For customers who do not have Microsoft Word, we have added a Zedmed RTF editor so you can create custom Office templates.
This is useful for on-premise customers moving to Zedmed Cloud. Learn more in our new Office templates guide.

NEW Banking Report enhancements

10 updates to Zedmed's banking reports to improve clarity and consistency.

Support has been removed for 3rd party SMS providers
Office ZED-8409 | Support for "SMS Everyone", "Inspirus" and "Other"(generic) SMS providers has been removed. ZedSMS
replaces these providers for the sending of SMS messages from Zedmed.
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ZedSMS performance updated

Office ZED-8832 K . X
The ZedSMS SendPoint was updated to improve the send and receive speed of SMS messages.
ZedSMS Purchase Link updated
Office ZED-8466 | Updated link to purchase credits for ZedSMS due to the change in supported providers. It now points to the

ZedSMS Message Centre.
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Office ZED-8418

Banking Report enhancements

The following enhancements have been made to Zedmed's Banking reports:

e Removed unused HealthPoint sections from bank reconciliation, deposit & session reports.
* Widened the payer name column On behalf of to accommodate longer names.
e Renamed the 'Bank Reconciliation Report' heading fromReversals to Cross-Session Reversals to

reflect the data presented more accurately.

Batches
Closed On Batch # Cash Cheques MC Chq Cards Total EFTPOS
23-Jun-2023 4 21330 0.00 270 10675 341335 4212.49 142 60
Totals 21330 000 270 10675 41335 4,212,483 142 60

HealthP oint

0.00

Totals 0.00
Direct Deposits
Date Paid by Bank Branch Details On behalf of Pay Date Amount
01dun2022  Medicare Reserve Canberra Dr Jackson Medicare 13245

e Updated the Bank list label to say, Show Inactive Bank Accounts (previously 'Show All Bank').
e New page on staff change checkbox is now only enabled if Group by staff member checkbox is ticked.

Banking Reports

Bank Deposit screen or the Print/Close Session screen.

Style
(®) Batch Details
Batch Number | <Current Batch>

OSession Dretails
Session Number | 34 Started On 15/03/2023 9:22:19 AM

OReconciIiation Report

From [o1/112023 A|F T [onuv22 2|F

Print Screen Export

Use this screen to print reports on previous and current batches and sessions. If you want to close a batch or session, please use the

To ensure this report includes all transactions from all other workstations, it is recommended you exit from all
instances of Zedmed Office running on this workstation and log in again.

Criteria
Banklist [Dshowlnacti\re BankAccount]
| Albert Road MC Bank Account v

D Group by staff member

Mew page on staff change

Test Branch 1 FDAVIS

e Fixed anissue where payments by staff would not print on separate pages if the option 'New page on

staff changed' was selected.

e Fixed anissue to prevent using the same reason text for all reversals made without closing the

payment enquiry form.
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Resolved an issue with the inclusion of cross-session reversals
The Banking Batch Details Report now takes into consideration any cross-session reversal transactions in
the overall totals section of the report.
Session Totals Overall Total 71.30
Cash 7130 Credi Card 000 Cheques 0.00
Direct Deposit 000 EFTPOS 000 Medicare Cheques 0.00
HeathPoint 000
Office ZED-8445
Banking Session# 2
Banking Session# 6
rCrou—t‘-‘;e“ion Reversals
2100712023 2 Black, Emma -7.30
L W rong pay ment in difierent ses
Report Totals Overall Total 71.30
Cash 7130 Credit Card 0.00 Cheques 0.00
Direct Deposit 0.00 EFTPOS 0.00 Medicare Cheques 0.00
. Changed the Banking Reconciliation Report date format
Office ZED-8463 . . .
The Banking Reconciliation report now consistently uses "dd/mm/yyyy" as the date format.
. Changed the date format for Reversals on banking reports
Office ZED-8500 . . . R .
Reversal transactions printed on banking reports now use "dd/mm/yyyy" as the date format.
Resolved an error encountered when canceling an invoice without a service record
This error occurred when creating an invoice, adding then removing a service and then trying to delete the
invoice. This error will no longer occur as the action buttons will be disabled when no service items are in the
service item list or in the add service item box.
Office ZED-8432 () Fund @ Medicare
Error >
Services
Date Item= Description Save invoice(s) error!! Press 'Cancel' button on Invoice Form to lotes
|JJ_ " " cancel the invoice!
Resolved performance issues caused by an Hl service outage
This fix prevents the Patient records from loading very slowly during the opening of multiple patient records
when the Hl service is down. The IHI check should now be run in the background for each individual patient
Office ZED-8436 | without slowing down the Ul performance.
Additional information has been added to the MHR Status section of the patient record and will display
when the IHI check is running and if the check times out it will update to display this information.
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Resolved anissue that caused a Patient's name to be cut off on the Patient Letter pick list.
In the Patient Pick List Dialog (Patient>Letters>Pick List) - Last letter of Family name was cut off due to the
font style.
Office | ZED-8480 |[Pick List
l} Carter Devall
[ Title From To Created CreatedBy  Bm Location |
Fixed Error 'Midnights not a valid time,' on the Waiting Times report.
Fixed an issue where an error was displayed when Midnight was selected as the End Time on the Waiting
Times report. Occurred when you select Daily Reports > Waiting Times > Select the End Time dropdown and
choose Midnight > Click on Print or Screen.
Report Critena
Office ZED-8530 (8) Detailed repart Entry Dat= [epemza 2| [oamamn =]
Group By  pipnd E1TeT cocumred b
Order By M‘h 6 ‘Midnight’ is nat 2 valid time. —Vl
() Waitng tmes by E | Details > > | i i
CPatient per haur i [ Send this error via Internet Copy ta Clipboard [ |
[ Attach a Screenshot image |
ApptjAttend (ab=r nﬂ |t Admission time= w
Resolved an issue that caused a patient's pronoun to disappear
Office ZED-8534 | Fixed anissue where clinic-defined pronouns (dropdown list management ) could disappear from the
pronouns selected for a patient.
Resolved a Booking Wait Time Report error and corrected the changes shown
The Booking Wait Time report will now display changes from the last edit made to an appointment.
Additionally, the report has been fixed to prevent an error when running the report for a single patient.
Booking Wait Times *
Star‘t - f_nd -
e 5 Period | 12/00/2023 12:00:01 AM~| 12/09/2023 11:50:59 PM~ |
g CowRinot congel varaet pE e [UnicadeSTmaynic e, Branch AL o
(Double). X
: Staff AL v
oK | Details > > |
Office ZED-8594 Send this error via Internet Copy ta Clipboard [] Patient |J””ES' Happy ‘ 1= patient
Exclude No Reason ()
Print I Screen ‘_ Close
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Resolved an issue with how the Date Details were display in Linked Appointments
The Linked Appointment Details dialog has been updated to use text formatting consistent with the rest of
the application. This resolved Linked Appointment Details - Date Details overlap.

Linked Appointment Details
Office ZED-8596
You have selected a linked appointment type for this patient ~Mame DOE  13/11/2002
appointment. Please enter the following information to Address

complete the linked appointment.

Original Appointment Details Linked Appointment Details Health Provider Availability

Date \Wednesday, 6 September 2023 IDate Wednesday, 6 September 20233t:| Wednesday, 6 Seplemberﬁ-l

Resolved issue with Patient Type details display in the Appointment and Attendance Details dialogs
The Patient Type in Appointment Details and Attendance Details screens no longer overlap the screen.

Appointment Details |
Office ZED-8598
e e createdby? - Simkips, Talia
r
Doctor GRACE HERMAN on 06/09/23at 12:08 oo rag Pull File Yes DOB 24/10/1982
Resource Frstin 31/01/2023  Lastin 16/08/2023 I Type Patient Type ABC:I

Clinic | Branch 1 ~|  ContactDetails

status (O - Phone (H) 01000000 Work (W) 02 0000000
Mabile 0410 654815

Start Time

Duration

An Assist Fee can no longer be used with non Assist able item
Office ZED-8657 | When setting a billing item as an assisted item that is not an assistable item, the Assisting Billing Options
screen is no longer displayed.

Resolved an issue with the Service date and Billing date range in the Assistant Service Report.
Office ZED-8658 | Fixed the date picker button for “To date” on the Assistant Service Report so that the date selected is
displayed in the To field and not the From field.

Fixed the layout of the reprint token message box.

Removed an incorrect line in the message displayed when reprinting an eScript token.

Confirm »

Printed token will not be valid if the presaiption has aiready been
filed. If the patient requires a reprint of a repeatissued by a
pharmacy, the pharmacy that issued the repeat token will be able
1o

Office ZED-8659 reprint a token for them. Would you ke to continue?

E Don't int Token 3

Reprint Token | Reprint

Office will still run if the cancel button is clicked on the Login screen.
Office ZED-8772 | Fixed issue where Patients.exe would crash when Office was closed without logging in first (i.e. opens
Zedmed Office, then closes the login prompt to exit, without logging in).

Selecting F4 twice will once again bring up the last patient searched.
Office ZED-8777 |Fixed issue where if a patient is associated with more than one branch selecting F4 twice (or clicking on Last
button) did not open the last patient.
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Staff Username truncates to 10 characters automatically
Office ZED-7492 | The "Edit Staff Member" dialog (Staff tab in the Securiy module) now prevents users from entering
usernames greater than 10 characters in length.
Added an Ethnicity field to Zedmed Clinical
Capturing or viewing a patient's ethnicity details has been added to the Family, Social & Past History
information in Clinical.
rI:'Eitient - Holloway, Mr Knut (He/Him)
Clinical ZED-8483 Patiént Details NOK and Emergency Contact ~ Family, Social & Past History  Smoking  Alcohol  Other Clinicians
Miscellaneous
Occupation hed
Sexuality | Unknown v Ethnicity| ., British, nec British; NORTH-WEST EUROPEAN =
v
Family History
-~ &
Resolved Ul Issues in Clinical Reports
Clinical ZED-8544 | Fixed some minor issues with font sizes and labels being cut off in the Clinical reports, including Font Types
or Font Size and Labels being cut off.
. Updated the Intramail Ul in Clinical
Clinical ZED-8552 L . . - . .
Clinical intramail buttons and icons have been updated on main dialog to match those in Office.
Fixed the Results Inbox Error: Unexpected end of command-line 2, column 1
Results Inbox has been fixed to prevent an error when retrieving results for all doctors on clinics with a large
number of doctors configured.
Error occurred x
Clinical |ZED-8561 e Unexpected end of command - fine 2, column 1.
Details >> |
[ Send this error via Internet Copy to Clipboard [
Enabled a configuration to limit attachments tab file size in clinical
Clinical ZED8574 | Added a maximum value in MB's for uploading of files to tabs in the summary views and set the default. This
can be found in the Global Options > General tab.
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Turned on Icon captions by default in Zedmed Clinical
Encounter icon captions are now turned on by default for users logging into Clinical for the first time.

Clinical ZED-8595

Current Encounter - Duration: 00:00:02

X VB L H K AB @ & ME

Problems Drugs Observations Referrals Immunisations Allergies Consumable Diagrams Templates Add Problem  Del Problem CDM  Calculators

Resolved a formatting Issue When Copying Clinical Notes to Letter Writer
Clinical ZED-8630 | Added a new Paste Plain Text option to the Letter Writer to allow formatted text such as encounter notes to
be copied and pasted into a letter without formatting.

Introduced a Filter Feature for Merge Fields in Letter Writer
The Clinical Letter Writer now provides a filter function in the data toolbar, allowing for a quick look-up of a
field in the list of available merge fields.

@& d|=E

Clinical ZED-8633 s = | == i .

i Filter o

Data Toolbar

& Chinical Detais
# Treating Doctor

Resolved an access violation in module 'crs_client.exe' when closing Patients in Clinical.
Clinical ZED-8687 | Fixed an issue where an AV error was displayed in some cases after closing a patient file in Clinical where My
Health Record is enabled.

Resolved an issue with My Health Record auto-upload displaying errors at a test site
Clinical ZED-8739 | The error occurred for patients with a hidden record and displayed a warning that has been fixed.

The Write referral button in HealthShare will now only be an option in Referrals.
Clinical ZED-8778 | Removed the"Write Referral" button from HealthShare address book search when opening the search
screen from the main toolbar in Clinical.

Removed obsolete Zedmed files and exe from the Installer/Upgrader

Upgrader | ZED-8614
PE The Zedmed Upgrader has been enhanced to remove obsolete files from client installations.

Zedmed v36.1.1

PDF viewer unable to view the document - Blank Document
Clinical | ZED-8668 |Fixed anissue that may prevent the viewing of older PDF files, especially those produced by scanning
documents

Zedmed v36.1.0

Zedmed v36.1.0 is a major release that introduces a modern theme, integration with accounting software including Xero and MYOB,
HealthLink SmartForm enhancements and pronoun and gender updates.
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Shortcuts to specific sections:

Zedmed v36.9.0
Zedmed v36.8.1
Zedmed v36.8.0
Zedmed v36.7.0
Zedmed v36.6
Zedmed v36.5

New Modern theme

New Modern theme

Surgical Partners integration
Zedmed v36.1.0 Updates (part of the v36.0.0 release)
Zedmed v36.0.0 HealthLink SmartForms enhancements
Zedmed v36.0.0 Office & Clinical enhancements
Zedmed v36.0.0 Office & Clinical updates

No menus or layouts have changed, but you now have the option to use the new Modern theme or the existing Classic theme.

File Encounter Results Reference Library Reports Tools Utilities Help

2]
o

2

o

Open Patient

Open Family

Close Patient

Holloway, Andrea .

Waiting room

Address book Travel Batch letter To do list

Holloway, Andrea

Address: 5 Kingsley Gr,
BENOWA 4217

DOB: 26/12/1943 Home:
Age: 79 years Work:
Medicare No: 49503503111 Mobile:
File No: 456 Occupation:
Hosp UR No:
MHR Status: Consent to Upload
Referrer: Dr Support Zedmed

©

iCurrent Encounter - Duration: 00:00:41

£ YO g

s Observations Referrals

‘ G) Undefined Problem
®) RFE: |

Immunisations Cons

A B

umable Diagrams Templates

[©®

Use Coded RFEs | Management Flan

O 8o wHE

E

Summary Views

Documents | Attachments |

Measurements |

Medications

| Problems | Referals | Results | Immunisations | Allergies | Images/ECG | Pregnancies

| Incoming Decuments |

T

Current Medications
Regular Use

PRN
Short Term
Non-current Medications

T Include MHR

Paracetamol 500mg Coated Tablet 500mg [20] - TAKE 2 TID
Paracetamol 500mg Coated Tablet 500mg [50] - TAKE 2 TID AS DIRECTED

Sort: |Medication Text w

e
History View

= Oldest Encounter: 20/05/2021
. Search Billing
€ 2‘ 1 3| 7‘ IE]| E|| History, {528 (yizara| Visible| Last 10 Cansutations v

Intramail

12/08/2022 (Fri) 10:00am with Dr Phillip Davis at MED, for 4h 23m 10s
parental anxiety

15/07/2022 (Fri) 10:54am with Dr Phillip Davis at MED, for 16m 085
Headaches

13/07/2022 (Wed) 11:21am with Dr Phillip Davis at MED, for 17m 455
Stomach ache

Include MHR

20/05/2021 (Thu) 5:09pm with Dr Phillip Davis at MED, for 0m 20s

Reference View

AHErg\Es:Icn‘"d"y peanut butter

Warnings: |

el
A
el

Recalls:|

&

Allergy: Crunchy peanut butter

e The first time you open Office and Clinical after the upgrade, you will be prompted to choose a theme.
e You can have matching or different themes in Office and Clinical.
e You can swap themes at any time if you change your mind.
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The first time opening Office - select Modern or Classic. To change -Themes > Modern or Classic.

intment Search View Refresh WaitingRoom Patient Bill Encounters RefDrs Close Extra & -
Management Reperts  Tools Practice Setup WP Setup  Uilities Help
Branch 1 -lHatcher. Danni  ~ Reception Management Modem ks
Gssic
27 Jun (Tue) 28 Jun (Wed) 29 Jun (Thul| Patients (F4)
ate
1 ZAM [ 0 0| |
- Waiting Room
© Modern S
qAu 0 0] 0|
Appointment Search View Refresh WaitingRoom Patient Bill Encounters RefDrs Close Extra
( ) [
£ 2 _ = [ PR i
e M Branch 1 Hatcher, Danni =
27 Jun (Tue) 28 Jun (Wed) 29 Jun (Thu)|
0| 0 0
BAIE
O Classic .l
74 0] 0] 0 Message of the Day
Welcome to Serenity i
Zedmed S/W Support
Tel: 1300 933 000
Fax 03 5264 3398
g After Hours: 0408 002 364
4 Month 4 Week 4 Day T'd’ Day J} Week b Month b 3Months B 6 Months B S M v
oday
The first time opening Clinical - select Modern or Classic. To change - Tools > My Options > Modern or Classic.

le_Encounter Resufts Reference Library _Reports] Tools ] Utilties Help

I My Options |

General | Drug Options | Document Handling | Function Seletions | My Heallh Record |

Defauts Images (Zoom To)

Fie Encounter Resolts Relerence Ubrary Reports Tocks Utiibes Help

- [] show Pathology Details Form Page Width
mith, Henr 4 Show Psthology Paper Request Prompt Whole Page
Smith, Henry 4
I cRs Close prompt. Problem Search Type ]
- Custom Size (%)
Sevith, Heney
CJsnow Audit Records Predictive Search (ICPC and Col v
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~ Patient Close Prompt &l
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OUBBO 2630 []Show Main Button Captions "0 Mot Recent ¥ Breast Fesding
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Surgical Partners integration

Surgical Partners is a financial management platform that integrates Zedmed with accounting products including Xero and MYOB.
This allows you to use the financial information in Zedmed for a range of financial applications from debtors' management to banking
and payroll. This functionality is enabled by registering with Surgical Partners who will configure Zedmed to send the required
financial data to your accounting software each night.
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To learn more, visit https://surgicalpartners.com.au.

Zedmed v36.1.0 Updates (part of the v36.0.0 release)

Implemented a new PDF tool to view results and scanned documents in Clinical
Clinical |ZED-8328 |Removed the requirement for Adobe Reader from Zedmed. PDFs can now be viewed (both when embedded
in aresult and when attached from a scan) without any external PDF viewer installed.

Access Violation error resolved when deleting an Appointment Type

Office | ZED-8252
Fixed an error that occurred when attempting to delete an appointment type from Office

Corrected the Message/Buttons displayed when a Tyro Easyclaim has been canceled.
Office | ZED-8360 | The message displayed when a user canceled a Tyro Easyclaim has been resolved and the form now allows
another attempt.

Deleted prescriptions are no longer displayed on HealthLink Forms.

Office | ZED-8423 __ . . I .
Deleted prescriptions were still showing up as selectable options in the HealthLink SmartForm.

The Encounter Timer no longer disappears when resuming an encounter.
Clinical | ZED-8452 |Fixed anissue where the Clinical Encounter timer would no longer be displayed after resuming an existing
encounter.

Updated the Appointment and Full day icons for the Modern Theme.
Office | ZED-8481 |Updated the iconsdisplayed on the Appointment Grid for Appointment and Full Day menu bar options so
they are no longer similar to Zoom In and Zoom Out icons.

Zedmed v36.0.0 HealthLink SmartFormsenhancements

For new users, please follow the Zedmed SmartForms installation guide.
For existing users, please follow the manual upgrade guide.
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Improved the names used for attachments in SmartForms
Each HL7 results file can include several sections, and Clinical Results Inbox displays them as follows:

1. Result View tab.

2. Enhanced View tab - HL7 file includes only 1 additional part.
3. Enhanced View #N - HL7 file includes N additional parts.

4. 2 and 3 are not always present, depends on HL7.

Results in HL7 files added as attachments to a SmartForm will be named as follows:

1. <HL7 FResult Name> (Result View) tab.
2. <HL7 FResult Name> (Enhanced View) tab - HL7 file includes only 1 additional part.
3. <HL7 FResult Name> (Enhanced View #N) - HL7 file includes N additional parts.

Clinical | ZED-8267 2 and 3 are not always present - depends on the HL7.

Requested Information 4k Diagnostic Reports / Patient Documents [ Browse for Patient Document ” Browse for Local File

Dermatology

Aftach file from EMR supports: gif, himl, jpeg, doc, docx, pdf, txt, rif, tiff
Altach file from Computer supports files that end in types: doc, docx, gif, him, himl, |peg, |pg. pdf, rif, tif, tiff, ta

Caution: larger attachments may take significant time lo preview

Attachments | Reports

M reports selected L Dty Campants b Sk

No flies aktached [ | 13/07/2023 = Attachment et 1KB
T 120712023 Colorectal Cancer Structured Tpeg

Medications, Allergies, Patholagy Report (Enhanced View

Alerts #1)

2 jor ecified [ | 12/07/2023 = Colorectal Cancer Structured himl

Pathology Report (Enhanced View
#2)

. . : [] | 120772023 Colorectal Cancer Structured pdi
Medical, Social and Family Pathology Report (Result View)
Jeiren PR "7 | 120772023 | Documents RTF fia ' T T 20k8
[ | 120072023 Images/ECG bt 1KB

E0E @ @@

Zedmed's Healthlink SmartForms integration is now upgradeable
Clinical |ZED-8292 | The Healthlink SmartForms service installer has been updated from an MSl into an exe file (as used by other
parts of the Zedmed software) so the software is now upgradeable.

Healthlink SmartForm will display 1 attachment for HL7 files with 2 records

Clinical | ZED-8332 The functionality of Zedmed's HealthLink SmartForms integration has been improved. HL7 results that
inica -
include PIT segments in addition to FT segments will be included as one attachment (as it is done in Clinical,

Results).
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Clinical | ZED-8379

The 'HealthLink Create Referral' button can be removed from the Encounter toolbar
Doctors can now remove the 'HealthLink Create Referral' button from the encounter toolbar. This is done in
Clinical > My Options > Function Selections tab > Show the HealthLink button.

[Current Encounter - Duration: 00:05:49

FoYD L DHBAB R

General Drug Options Document Handling Function Selections  hy Health Record h

My Options

41 5how the Problems button

[ show the Preseriptions button
[ Show the Observations button
[£] show the Referrals button

[ show the Immunisations button
4] show the Allergies buttan

[ show the Consumable button
[ show the Diagrams button

[ show the Templates button

[ show the Add Problem button
[] Show the Delete Problem button

[ Show the Pregnancy button

[ Show the Chranic Disease Module button <] @& Indude MHR

[1Show the Clinical Calculators button
[ Show the Capture button

[~ show the Histories button

[ show the Spelicheck button

[] show the Backdate button

[DShdw 1he Create New HealthLink Refe ral button ]

Clinical | ZED-8387

Resolved a scenario where a staff name could appear as the provider in a SmartForm

Resolved an issue that caused the provider details ( Referred By name) in a HealthLink SmartForm to be
populated with a staff member's details instead of the provider's details, when the staff member's ID was the
same as the doctor's code.

Zedmed v36.0.0 Office & Clinical enhancements

Clinical | ZED-7979

New Pathology & Radiology referral templates added to the Clinical Addressbook for:

e Australian Clinical Labs Comprehensive Carrier Screen Request = PathologyClinicalLabsCCS
e Queensland Ultrasound for Women = RadiologyQUFW

e Sydney Ultrasound for Women = RadiologySydneyUltrasoundForWomen

e Vision Radiology = RadiologyVisionCardiac

Laboratory Details

|:| Use As Preferred Laboratory
[ IPRS PP Fia i olo oy clbourmeRadChinic DL Command Line |

RadiologySydneyUltrasoundFarWomen a "

RadiclogyToowoembaDiagnosticimaging DL Directory D'

RadiologyUniRad UL Directo

RadiologyUniRadiology o D'
RadiologyUniRadiology2
RadiologyVictorianMedicallmagin

Lab Communications

Vertical Offset{mm)

Update Details fro 7 Help W 0K X cancen

RadiologyWesternimagingForwomen ¥

Pronoun field added to Zedmed Office & Clinical
Added support for specifying preferred pronouns to Zedmed. Pronouns can be set in either the Office or
Clinical Patient Details forms and are displayed in the following locations.

e The selected pronouns will appear when chosen in the patient record Pronouns drop-down.
e Enabled at practice and branch level.
e Additional pronouns can be added in Practice Setup > Drop-down List Management> Pronouns.
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Office/
Clinical

ZED-1674

Checklists
Instrument
Procedure Type
Product Category
I Pronouns

¥4 Drop-Down List Management

Appointment Cancellation Reasons Description

He/Him
She/Her
They, Them

Prosthesis
Stock Movement Reason

Add Value | | Delete Value

Fladgive Q& Omep Q3 [Jers

[m] x

Pronouns display:

e The header of patient details summary in Clinical.
e Title of patient details in Clinical.

e

7
Open Pabient Open Family

Jones, Mr Happy (They/Them) n

Jones, Mr Happy t'l'rn-y_fThum}

e Patient record tabin Clinical.
e Title of patient details in Office.

Receipt Waiting Room  Appointments  Extras

B) Tone: Hanny (They Them ]
AccEnquiry Attend”  ©N  Letters  Clinical information  Print  Quote
Patient Details [ Personal ; F :
L . - d Family Name | Jones |
Further Details *

T [ -y
Recalls Given Name |.Hapmr | Initial
Notepad Preferred Name | | e
eHealth Title [Mr SexatBitn M
Messages Pronouns !Thc;.-"l'hcln ]

Practice
Filew {22

Hosp. UR No
L

Usual Branch  Branch 1 (22)
First in |

Type

[

Pronouns & Sex at Birth
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¥4 Jones, Happy X
AccEnquiry Attend  Bill  Letters Clinical Information  Print  Quote Receipt Waiting Room  Appointments  Extras
Changedi.Gender *toSex at Birth" Padice: —————————
Civéngietithe "Gender” field to Feat irthinOffice. Cliiaical and the 'mmve—pgﬂ L Lt
. @ Ehe enaer 1ie (0] calan e € UTHItY-
Office ZED-8194 Recalts Given Hame [Happy Tnitial Hosp. UR No | | L¥niul Warnings
| Notepad Preferred Name | | Former Usual Branch | Branch 1 (22) ~
>§m§t§creenshot above. Title Ml I Sex at Birth ‘l:!rq First In | Last In
Messages W ﬂ Type [ Status | Current |2
Date of Eirth Age 58 Family
. o . . e | p3he/Her .
Fthnicity is available/inthe Patient-Merge utiljty * Jones, Happy (22) v
Office ZED-8202 |Ethnicity is now available in the-RPatient-Mergeutility-when-m: gingrahuplieate records. It is displayed when
Suburb [ISABELLA PLAINS
AdvanCEd IS SEIeCt%elud Contact Branch Default not set) = Payers
Method
[ = L -_
%o [Mobite || ] Fund  No fund set for this patient
Do Not Send SMS [ | Default Appointment SMS [:] = s Claims
Changed the default doséféPPrevenar 13 Childhood immunization
Referrals
Updated the dose from m&f@mﬂzﬂonm Pagumococcal (JJ.SVPCV) Childhood Scheduledtmmunisation
Veteran | | & | = e
Childhood Immunisation Schedule boa
Natiul_'ba_l Immunisa_tiun _Prog(all} Sc_hedule - Jul)_' 20_20 :
Vaccine Brand/Vaccine Date Batch Comment Dose Doctor Add... |
» 12 Months ~ [
MMR 1 Madify... |
Clinical | ZED-8215 AeMency ) |
13vPCV 3 Deiete.., o
12 Months - in SA as Dose 3 OR ATSI only as Dose 4 I—
Tenk 3
**Transterred to different card, Old card quoted,**
| petete || mint || patientvertication | | Fing Cose || cancel
Added the Service date to the Claims screen and Claims Report
Claims Status Ul and report now show the date of the service against each item in the invoice.
¥4 Claim Status
Refresh Default View Expand All Collapse All Void Rejected Invoices
Claims  payments
Office ZED-8326 ; :
From [11/07/2023 [E~ | @ |AlSubmitted ClaimTypes | Branch <All> ~| Dodor |<All> ~ | Claim ID
To 18/07/2023 [~ | O Mot Submitted Status  <All> w| patient [aN Find Patient Clear |
O Irw.fServi(e,fJ\i;ls;or Status Patient CQutstanding Paid Doctar Claim ID Medicare
B[ Inv103015 18/07/2023 WITHME...  Simkins, Talia $331.50 S0.00 Augustus Eason 211307 211307
1186 4/07/2023 Unpaid 5110.50 50.00
16 11/07/2023 Unpaid §110.50 s0.00
116 18/07/2023 Unpaid 511050 50.00
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Office

ZED-8370

Replaced the PDF viewer for the "View Claim" button in Account Enquiry
Updated the application used to view PDFs in Office for Claims. Viewing a claim from the account enquiry
screen is now significantly faster.

4 Account Engui

Patient  Simkins, Talia

Payer Simkins, Talia w Recalculate
Curmr 331.50 30+ 0.00 60+ 0.00 0.00
Transacton
Invoices Data Patient HIC  CLM# B Dr Value Qutstanding
>-I 103015 18/07/2023 SIMKINS, TALIA P4 PDF Viewer

“ Save s [Eiprint (5 Puint (with printer selection) | - FtWidih | FitPege J® ZoomIn /= Zoom Out

Patient Claim Consent and Declaration

Location ID: SAP02482 Reference: 211307

Zedmed v36.0.0 Office & Clinicalupdates

Important update.
Clinical ZED-8286 Reduced the flicker on the Results Inbox display list
Results Inbox module has been reworked to prevent flickering as users action results.
Resolved an error that occurred when merging patients with the same SMS message
Office ZED-5462 When merging patients that reference the same SMS message, Zedmed Patient Merger will now only move one copy the message to the merged record. Previously it would
report an error and abort the merge process.
The Last (F4) Button now works in Appointments
While searching for patients on the Appointments Ul, selecting the Last F4 button now selects the last opened patient in the appointment search dialog.
| <Al Doctors> | IRCIINCS
Tue Hatcher, Danni HEDRICK WARREN HERMAN, GRACE Davis, Phillip
gau 0 0 O o
30|
45,
g [ 5 O 9
15]
30 30| 22 Jones, Happy
45 45 17 Janes, Marrianna.
Office ZED-5494 10 | ° i ] °
15] 15| E 15‘ 15]
30| 30/
| Search for Appeintments L
5 s =
PERE 0 Patient Jones, Happy Drna —]
75| 5| from (s | [ To o204 3| u
2 = Date Time  Duration Doctor Resource Granch Status  Notes o
= |+ T Tue 18/07/2023 9:30:00 A 10 PD MED  Active I
1 Zm o 0| N
15
30
45
PEY [ 0 B | |
15| < >
30,
Print List Delete Refresh Close
s
e
Office ZED-7111 The Delete button in Staff Maintenance>Apps Access no longer causes an Access Violation
The Delete button on the staff permissions maintenance dialog, App Access tab, will now remain disabled until a selection has been made to prevent an error.
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Resoved Error Data too large for variable [[TEM_CODE]. Max len = [8], actual len = [9] when running AMA Fee Load
The Load MBS/AMA Item By Criteria option now works when the Load from AMA file checkbox is selected and an AMA load fee file is used. AMA fees will now be loaded as
long as the corresponding MBS item already exists, a report is displayed at the end of the import listing the items that could not be imported.
Load MBS/AMA item X
(®) Load MBS/AMA Item By Criteria
 Update Existing MBS/AMA ftems
Loading Criteria
Item Number
Category | i
Group -
Sub Group
Loaded ltems
Item Mumber Commence Date
Short
Description
Full
Deseription
Office ZED-7982
Number of Items Loaded : ] Continue Without Short Description
Load Item I E Load from AMA file | Clase Cancel
Office ZED-7983 Resolved Error - Param [NEWSTARTDATE] type changed from [ftSQLTimeStamp] to [ftDateTime] running AMA Update Fees
The Update Existing MBS/AMA Items with the Load from AMA file option selected will now run without error and enable the update AMA items.
Office ZED-8233 Statistics report - Referral Doctor criteria now correctly lists all address book entries (not just referral doctors)
Referral Doctor criteria in the Statistics Report will now only list Referral Doctor contacts who are set as Available.
Office ZED-8247 Resolved Error "Zedmed Office was unable to load the OLE object file" when you Select or Preview an archived letter
Fixed the issue with an error being displayed when selecting or previewing patient letters that have been archived.
Clinical ZED-8248 Resoved Error 'Type ID Mismatch' when importing CDA letters
When importing HL7 messages that contain XML files with a namespace prefix, Zedmed Clinical will report a more accurate error instead of returning "Type ID mismatch".
Office ZED-8362 Resolved an Intramail error in Sent Items
Fixed an error that occurred when viewing sent items in office intramail when the To: or CC: fields contain a combined total of more than 1000 characters.

For the most up-to-date documentation version, visit https://help.zedmed.com.au/help



Office

ZED-8367

A double booking Patient's name will no longer change when editing the appointment.
Modifying an appointment by selecting it from the appointment selector (appointment 'Details' context menu option), no longer displays a different patient in the
appointment selector at the end of the process.
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